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FCC Note

The products described in this manual have been found to comply with the limits for a Class 
A digital device, pursuant to Part 15 of the FCC rules. These limits are designed to provide 
reasonable protection against harmful interference when the equipment is operated in a 
commercial environment. This equipment generates, uses and can radiate radio frequency 
energy and, if not installed and used in accordance with the instructions in this Guide, may 
cause harmful interference to radio communications. Operation of this equipment in a 
residential area is likely to cause harmful interference, in which case the user will be required 
to correct the interference at his/her own expense.

EN 55022: 1998, Class A Note

Warning: This is a Class A product. In a domestic environment this product may cause radio 
interference in which case the user may be required to take adequate measures.

Caution: The products described in this manual are approved for commercial use only.
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User Guide

About this manual

Purpose of this manual

This manual tells you how to install, configure and use the PCI-RAS product. 

Who this manual is for

This manual is aimed at users of communications servers who need a multi modem solution. 
This manual requires a working knowledge of using personal computers and associated 
operating systems.
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Using this on-line manual

The following is a brief guide to using this manual on-line.

Document navigation

This manual features document navigation hypertext buttons in the header area as shown in 
the next picture;

Hypertext jumps

You can also navigate around this manual by clicking on any cross reference or text in blue 
for example, Hypertext jumps. 

Jump to Using this on-line manual

Jump to Index

Jump to Quick Reference 

Jump to previous location 

Jump to front of current chapter

Jump to Contents

Jump to Fast contents

Note
The Fast Contents, Contents and Index entries are all hypertext 
jumps into this manual.
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User Guide

Chapter 1  Introduction

You need to read 
this chapter if you 
want to...

You need to read this chapter if you want an introduction to the PCI-RAS multi-modem card.

This chapter provides an introduction to the PCI-RAS multi-modem card and its main 
features.

This chapter includes the following sections;

• About the PCI-RAS card on page 12

• Cables on page 12

• Getting support on page 12

• PCI-RAS features on page 13.
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About the PCI-RAS card

PCI-RAS is a 4 or 8 port, 56K V.92 multi-modem solution. This unique card is ideal for 
building communications servers on Window and UNIX systems. Applications include:
• Dial-in access for remote workers and sales staff

• Dial-out capabilities to branch or retail locations for data collection

• Creating ISP servers for Internet/Intranet capabilities

We've combined a decade of serial I/O design with the PCI-RAS software to give our 
customers a unique server solution for:

• Windows NT, Microsoft Terminal Server

• Windows 98 and Windows 95

• UNIX variants (Linux, SCO).

Cables

Each PCI-RAS product is shipped with cables, the type depending on the country being 
supplied as follows;

Getting support

See Appendix B Contacting Perle for details of technical support.

Country Product Cable type supplied 
USA PCI-RAS4  RJ11 to RJ11

PCI-RAS8  RJ11 to RJ11 
Europe PCI-RAS4  RJ11 to RJ11 

PCI-RAS8  RJ11 to RJ11 
UK PCI-RAS4 1.5m RJ11 to BT Plug cables

PCI-RAS8 1.5m RJ11 to BT Plug cables
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PCI-RAS features

The PCI-RAS multi-modem card is designed to integrate multiple 56K V.92 modem ports into 
small business servers - simply, securely and cost effectively. This product is ideal for remote 
access, Internet and messaging applications in Windows NT and UNIX server environments.

The PCI-RAS hardware specification includes:
• 4 or 8 port V.92 modems

• V.34 fax protocol support

• 32 Bit PCI Bus, full PCI plug and play compliant

• 64 Byte transmit and receive FIFOs on each port

• Full hardware flow control

• Single interrupt required per card

• Software controlled hardware reset for each modem

• Full data, fax and voice support on all modem ports

• Windows based diagnostic and management software

• Modem hardware based on industry standard Multitechmodem chipset

• I/O ports using TI TL16C754BPN enhanced UARTs

• 230.4 Kbps data-modem interface

• 4 port Dimensions 202mm x 114mm

• 8 port dimensions 315mm x 114mm
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The PCI-RAS operating spec includes:
• Data Compatibility: V.92, V.34 enahnced, V.32bis, V.32, V.22bis, V.22; Bell 212A and 103/

113, V.21 & V.23

• Fax Compatibility: ITU-T “Super” Group 3; Class 1.0, 2.0, 3,1; Group 3, Class 1 and 2, 
T.4, T.30, V.21, V.27ter, V.29, V.34,V.17 and TIA/EIA TR29.2

• Error correction V.42 LAPM, MNP 3-4

• Data Compression: ITU-T V.44 (6:1 throughput); V.42bis (4:1 throughput); MNP 5 (2:1 
throughput)

• Drivers supplied for Windows NT, Windows 95, SCO IFS, SCO OSV, Linux

• Support for up to 8 cards per server

• Operating temperature: 50 o F to 110 o F (10 o to 45 o C)

• Storage -20 o to 65 o C (4 o to 149 o F)

• Relative humidity: 5% to 90% non-condensing

• Altitude: 0-12 000ft (0 to 3660m)

• FCC Part 15 Class B
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Chapter 2  Installation

You need to read 
this chapter if you 
want to...

You need to read this chapter if you want to install the PCI-RAS onto your system.

This chapter tells you how to install your PCI-RAS hardware and also describes associated 
software procedures.

This chapter includes the following sections;

• Before you start on page 16

• Installing your PCI-RAS card on page 17

• Installing PCI-RAS under Windows NT 4.0 on page 18

• Installing PCI-RAS under Windows 2000/XP/Server 2003/Vista/Server 2008 on 
page 21

• Installing PCI-RAS under Windows 95/98/ME on page 26

• Installing PCI-RAS under SCO OpenServer on page 30

• Installing PCI-RAS under SCO UnixWare on page 39

• Installing PCI-RAS under Linux on page 47

• Installing PCI-RAS under Solaris on page 50

• Remote Configuration on page 56

Note
The procedure for installing and configuring PCI-RAS cards varies for different operating 
systems. Please read Before you start on page 16 before commencing installation.
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Before you start

Before you install your PCI-RAS cards and software, note that the procedure for installing 
and configuring PCI-RAS cards varies for different operating systems. 

To install under a particular operating system, please refer to one of the operating system 
specific installation procedures listed below;

• Installing PCI-RAS under Windows NT 4.0 on page 18

• Installing PCI-RAS under Windows 2000/XP/Server 2003/Vista/Server 2008 on 
page 21

• Installing PCI-RAS under Windows 95/98/ME on page 26

• Installing PCI-RAS under SCO OpenServer on page 30

• Installing PCI-RAS under SCO UnixWare on page 39

• Installing PCI-RAS under Linux on page 47

• Installing PCI-RAS under Solaris on page 50

The following NOTE applies to all installations of PCI-RAS cards within the above listed 
Operating Systems. 

Note:
Remote modems connecting to PCI-RAS cards that are made by US Robotics require a 
&b1 to initialize the speed correctly. 
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Installing your PCI-RAS card

To install a PCI-RAS host card proceed as follows;

1. Turn off the power to your system and disconnect the mains supply.

2. Remove the system cover to expose the inside of the connector panel for host cards.

3. Insert the PCI card you want to install into a vacant host card slot and secure in place as 
shown in the next picture (pciras4 shown).

For PCIRAS8 cards the rear of the card is fixed in place using an offset plastic retainer.

4. Repeat step 3. until you have installed all the PCI cards you want.

5. Replace and secure the system cover.

Installation of PCI host cards is now complete.

Warning
Dangerous voltages exist inside computer systems. Before 
installing host cards in your system, turn off the power supply 
and disconnect the mains lead.

Caution
Full anti-static precautions should be taken when handling host cards.

Offset retainer bracket holds card 
in fixing slot, not rear card edge

 Push into rear 
card fixing slot
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Installing PCI-RAS under Windows NT 4.0 

Installing the driver

The PCI-RAS hardware has no switches or jumpers to configure. To install the card;

1. Turn off the power to your computer. 

2. Remove the computers cover.

3. Plug the PCI-RAS card into any free PCI slot of your PC server and fix it securely. 

4. Reassemble the PC enclosure and restart the PC. 

5. Connect the telephone cables.

Once the PCI-RAS card has been installed, you can install the support software supplied 
with it. 

6. Run the setup.exe program in the directory: \drivers\pci-ras\nt4\port director\x.y.z, where 
x.y.z is the version, on the CDROM supplied with this product.

7. A welcome screen now appears. Continue installation by click the Next button.
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8. The Select Destination Directory menu will appear. It is suggested you use the default 
directory supplied (c:\Program files\PCI RAS).

9. Port Director Setup is now complete.
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Using modems

1. Click on the Port Director icon to start the Port Director configurator.

2. Click on the SPEED Serial Device Driver to display the available com ports.

3. Click on each individual com port to view and change the communication parameters

Your PCI-RAS card should be ready to operate with your communications software.
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Installing PCI-RAS under Windows 2000/XP/Server 2003/
Vista/Server 2008

Installation Overview

When you install the PCI-RAS Windows device drivers, you are actually installing three 
different componets:

• PCI-RAS COM ports

• Multitech Systems Modems

• Unimodem Half-Duplex Audio Devices

To install all three components, do the following:

1. Install the driver. See Installing the driver on page 18.

2. Using the Hardware Found wizard, install modem and audio device drivers by pointing to 
the directory where you unzipped the installation files.

Installing the driver

Windows 2000/XP/Server 2003/Vista/Server 2008supports any mixture of PCI-RAS 4 or 8 
modem cards. The PCI-RAS Windows 2000/XP/Server 2003/Vista/Server 2008 setup files 
are located on the Perle CD and can be downloaded from the Perle website. With the new 
card(s) installed correctly, power-up the PC and Windows will automatically detect the new 
card(s).

To install the Windows 2000/XP/Server 2003/Vista/Server 2008 PCI-RAS driver, do the 
following:

1. Turn off the power to your computer. 

2. Remove the computers cover.

3. Plug the PCI-RAS card into any free PCI slot of your PC server and fix it securely. 

4. Reassemble the PC enclosure and restart the PC. 

5. Click “Cancel” when the Found New Hardware wizard appears.

6. Connect the telephone cables.

Once the PCI-RAS card has been installed, you can install the support software supplied 
with it. 
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7. From the Perle CD browse to the PCI-RAS Windows 2000/XP/Server2003/Vista/
Server 2008 drivers page or download the zip file from the Perle website for your 
operating system:

pserial-x86.zip for 32-bit Windows operating systems.

pserial-amd64.zip for 64-bit Windows operating systems.

pserial-ia64.zip for 64-bit Windows Itanium operating systems.

8. Unzip the driver zip file to a local directory. We recommend that you use the 
pserial-setup-<arch>.exe file, which will launch the installation wizard, to install the 
PCI-RAS driver.

Double-click the pserial-setup-<arch>.exe installation executable and follow the 
installation wizard steps.

9. Continue the installation process through the Perle-Serial <version> Setup Wizard.

Note: During the installation, you may get a Windows Logo message. Click “Continue 
Anyway” when these appear.

Note: If you are installing an unsigned driver, you may have to click through the Found New 
Hardware wizard for every PCI-RAS modem on your system.

10.Restart the computer.

Adding additional modem cards and/or updating drivers

Whenever you add any additional PCI-RAS hardware to your system, Windows might install 
the latest digitally signed driver in its database (depending on your Windows operating 
system and settings). To ensure you have the latest driver installed after you add new 
hardware, you can either:

• Click Start > All Programs > Perle > Perle-Serial > Update Driver

or

• Reinstall the drivers as described in Installing the driver on page 21.
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Configuring Modems

After all of the PCI-RAS components have been installed, you can configure the modems by:

1. Clicking on the System icon in the Control Panel.

2. On the Hardware tab, click the Device Manager button.

3. Expand the Modems entry.
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4. Right click on the MultiTech Systems modem entry and select Properties. Click on the 
Modem tab to change the speaker volume, baud rate, or dial control.

5. Click on the Diagnostics tab and click the Query Modem button to help determine how to 
fix any modem issues you are experiencing.
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Using modems

1. Bring up the Control Panel and select the "Network" icon. 

2. If "Remote Access Service" is not in the Installed Network Software list, click on "Add 
Software..." to install it.

3. Highlight "Remote Access Service" and click on "Configure..." to get "Remote Access 
Setup". 

4. Click on "Add..." to get the "Add Port" menu, and select a COM port from the drop-down 
menu. Manually select your modem. 

5. When you're finished adding, click on "Continue..." and "OK"

After installing your modems, you will need to reboot Windows environment 
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Installing PCI-RAS under Windows 95/98/ME

Installing the driver

PCI-RAS works with Windows 95/98 installations. It is important to make sure you are using 
the "Plus" version of Windows (which includes Remote Access Server software).

To install the PCI-RAS card, 

1. Shut down your system and install the card in an available PCI slot.

2. Reboot the system. 

Windows 95 detects that the card is installed in the system. 

3. When prompted for the source of the driver files, browse to directory
\pci-ras\drivers\win_9x\x.y.z, where x.y.z is the version, on the CD and click OK.

The following screen will appear:
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4. Proceed with Next. 

Windows 95 searches for the driver in possible locations (i.e. drive a: on Windows 95, 
multiple locations on Windows 98). The following screen should appear:

5. Proceed with Finish. 

When the install wizard finds the driver the following screen will appear:

6. Proceed with Finish.
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Using modems

After driver installation, the driver should then automatically find all of the ports, and the 
modems on each of the ports. For example:
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To test the installation, double-click one of the COM ports in the modem control panel. The 
following screen should result (with minor differences):

Your PCI-RAS card should be ready to operate with your communications software.

Uninstalling the driver

To remove a PCI-RAS installation;

1. Go to the Control Panel then to the System icon. 

2. Under System, choose the Devices Manager. 

3. Then select the Multi-function adapters to look for the PCI-RAS card and select Remove. 

4. You should now remove the card itself.
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Installing PCI-RAS under SCO OpenServer 

Installing the driver

To install the PCI-RAS device drivers and utilities for the SCO OpenServer operating system 
proceed as follows;

1. Login to your system as super user.

2. Load the CDROM into your system CD drive.

3. At the command prompt, make a directory for your installation by typing:

mkdir /cdrom

4. Mount the CDROM file system using the following commands:

mount -f ISO9660 -r/dev/cd0 /cdrom 

5. In the SCO OpenServer desktop, double click on the System Administration folder.

The System Administration window is now displayed.

6. In the System Administration window, double click on the software manager icon.

Note
The example above shows the directory name as /cdrom, You can either use this 
name or use another directory name to suit your requirements. For example, /mnt.
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The Software Manager window is now displayed.

7. In the Software Manager menu, click on Software > Install New.

The Begin Installation window is now displayed as shown in the next picture.

Click here to 
select the local 
host as the host 
machine. 
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8. In the Begin Installation window, select the local host as the machine to install from by 
clicking on the From localhostname button and then click on Continue.

The Select Media window is now displayed.

9. In the Select Media window, using the Media Device selector choose the Media Images 
option then click on Continue.

The Enter Image Directory window is now displayed.
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10.In the Enter Image Directory window, enter the following in the Image directory field;

/cdrom/drivers/pci-ras/openserver/x.y.z , where x.y.z is the version number of the 
driver for SCO OpenServer 5.

/cdrom/drivers/pci-ras/openserver6/x.y.z , where x.y.z is the version number of the 
driver for SCO OpenServer 6.

11. In the Enter Image Directory window, click on OK.

The Install Selection window is now displayed.

Note
The example and picture above show a directory name including /cdrom, You can 
either include this name in the path or use another directory name to suit your 
requirements. For example, /mnt.
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12.In the Install Selection window, click on the Install button.

The following progress message is now displayed.

The above window will display various progress messages and then the Speed 
Installation Options window will be displayed.

13.If required, in the Speed Installation Options window, select the Re-Link kernel option.

14.In the Speed Window Installation menu, click on Options > Exit to close the window and 
continue the installation process.

If you select Re-link kernel, a message window is displayed at the end of the driver 
installation prompting you to re-boot the system.

Hint 
If you are installing more then one driver, you can de-select this option until you 
have installed all the drivers and utilities you require to save time.
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15.In the message window click on OK to continue the installation process.

The following message is now displayed upon completion of the installation process.

16.In the message window, click on OK to close the window.

The software manager window is now updated to show the driver you have installed as 
shown in the next picture.

17.In the Software Manager window, click on the Host > Exit menu option to close the 
window.

18.Shut down your system and turn the power off.



PCI-RAS User Guide 
Installing PCI-RAS under SCO OpenServer

Page 36

Chapter 2 Installation

Serial port naming conventions

Each serial port has one device node associated with it. Each node takes the form of a file 
which you can access from operating system utilities and user applications. Details of this 
node is shown in the next table.

Setting up modems for dial in

To setup the modem under the Openserver environment for dial-in, the following instructions 
need to be implemented in order to set-up for a “getty” dial in. 

1. In the Perle-Speed folder for OpenServer 5 or the Perle-Serial folder in OpenServer 6, 
run the application “Speed Port Configuration” and disable the Login Session for all the 
modems. 

2. In the /etc/initab file, ensure the line containing the modem version of the port is loaded 
via the respawn getty directive. For modem port 1, the line will be similar to the following:

Z1:234:respawn:/etc/getty ttyZ1 q

NOTE: Keep track of the getty definitions used since the serial port speed is needed for the 
following directions. Refer to the file /etc/gettydefs for the complete list of definitions. 

3. Issue a enable ttyZ1 command (for port 1)

4. In the /usr/lib/uucp/Devices file add a line for every dial-in port in order to access the port 
with the cu command. For example, for port 1 the line would be:

Direct ttyZ1 - 115200 direct
NOTE: the 115200 can be substituted with the speed used in your getty definition. 

5. Issue the cu -l ttyZ1 command (for port 1) to individually access each modem. For each 
modem enter the following init string

at&fs0=1$sb115200&d1&w
where the 115200 can be substituted with the speed used in your getty definition. Ensure 
the modem responds with an “OK”

6. Quit the cu program with a “~.”

Device name Function Description Location
Z1 Modem port Indicates that a port open will 

not complete unless DCD is 
present

/dev/term

NOTE: For older PCI-RAS multi-modem cards, without V.92 support, you will 
get an error response from the modem and should use the init string 
at&fs0=1&d1&w instead.
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Removing drivers and utilities from your system

To remove the SPEED device drivers and utilities for the SCO OpenServer operating system 
proceed as follows;

1. In the SCO OpenServer desktop, double click on the System Administration folder.

The System Administration window is now displayed.

2. In the System Administration window, double click on the software manager icon.

The Software Manager window is now displayed.

3. In the Software Manager window select the driver you want to remove.

4. In the Software Manager menu, click on Software > Remove software.

A confirmation window is now displayed prompting you to confirm removal



PCI-RAS User Guide 
Installing PCI-RAS under SCO OpenServer

Page 38

Chapter 2 Installation

5. In the confirmation window, click on the Remove button.

The software is now removed and the following Kernel re-link message is now displayed 
as shown in the next picture.

The Kernel re-link message window now closes and the removal continues. A message is 
displayed upon completion.

6. In the message window, click on OK to close the window.

The software manager window is now updated to show the remaining software.
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Installing PCI-RAS under SCO UnixWare 

Installing the driver

To install the PCI-RAS device drivers and utilities for the SCO UnixWare operating system 
proceed as follows;

1. Login to your system as root.

2. Load the CDROM into your system CD drive.

3. Mount the CDROM to a mount point, for example /cdrom.

4. At the command prompt, type:
pkgadd -d /cdrom/drivers/pci-ras/unixware/x.y.z/spd-uw-x.y.z.pkg spd , where x.y.z 
is the version number of the driver. 

5. Press the Enter key. 

The system now installs the driver and displays a series of messages ending with a 
successful installation message.

Upon installation of the drivers, your PCI-RAS cards are ready to use.

Note
A re-boot of your system is not necessary as the drivers for your PCI-RAS card are 
dynamically loadable and will be loaded as soon as any software attempts to access the 
associated devices.
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Serial port naming conventions

Each serial port has one device node associated with it. Each node takes the form of a file 
which you can access from operating system utilities and user applications. Details of this 
node is shown in the next table.

Device name Function Description Location
Z1 Modem port Indicates that a port open will 

not complete unless DCD is 
present

/dev/term
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Setup for dial-in modems

The software provided with the SCO UnixWare operating system includes a utility called 
Serial Manager which allows you to configure the extra serial ports you have added to your 
system. 

To configure serial ports with Serial Manager proceed as follows;

1. At the command prompt, type scoadmin
The System Administration window is now displayed as shown in the next picture.

Note
On UnixWare 7.0, you must apply a patch file called ptf7053 before using the Serial Manager. 
You can find the patch on the SCO web site at;
http://www.sco.com 

http://www.sco.com
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2. In the System Administration tool window, click on the Hardware folder and then select 
Serial Manager
The Serial Manager window is now displayed showing the host cards (including SPEED) 
currently present on the system.
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3. In the Serial Manager window, select the host card you want. Then in the Serial Manager 
menu, click on View > Ports.

The Serial Manager window now displays the ports available for the selected host card as 
shown in the next picture.
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4. In the Serial Manager menu, click on Ports > Modify.

The Modify Serial Port window is now displayed.

5. In the Modify Serial Port window, set the parameters shown in the next table

Parameter Set to
Port Type Local Terminal
Configure port incoming and outgoing as applicable
Speed the speed value you require

Note
Because the system does not support the selection of speeds above 
115200 bps, lower baud rates have been permanently remapped to support 
higher port speeds. Remapped speeds are shown in the next table.

Selected speed (bps) Actual speed (bps)
50 230400
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6. In the Modify Serial Port window, click on the Port settings button.

The Port settings window is now displayed.

7. In the Port settings window, select the Data bits and Parity values you require and click 
on OK.

8. In the Modify Serial Port window, click on OK to accept the changes you have made and 
close the window.

9. Repeat steps 3. to 8. until you have configured the serial ports for all the host cards you 
require.

10.In the Serial Manager menu click on Host > Quit  to quit Serial Manager and close the 
window.

11.Use the Serial Manager ensure all PCI-RAS ports are configured as Terminals with 
Logins disabled

12.For each PCI-RAS port you need to run the cu command in order to set the dial-in serial 
speed. For example, to connect to port 1 at 115200 bps use the following command:

cu -s 115200 -l term/z1
13.Once connected, you will be able to perform AT commands to that modem. Enter the 

following command to the modem:

AT&FS0=1$SB115200&D1&W
NOTE: the speed (115200 in the above example) must match the speed parameter used 
in the cu command.

14.Quit the cu program with a ~

Once all the dial-in ports have been set-up, use the Serial Manager to enable Logins and set 
the speed of the port to the same serial bit rate that was used in the cu command. 

NOTE: For older PCI-RAS multi-modem cards, without V.92 support, you will 
get an error response from the modem and should use the init string 
AT&FS0=1&D1&W instead.
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Removing drivers and utilities from your system

To remove the software drivers from your system under the SCO UnixWare operating 
system proceed as follows;

1. At the command prompt, type pkgrm spd and press Enter 

The SPEED driver and associated utilities are now removed from your system..
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Installing PCI-RAS under Linux 

Installing the driver

PCI-RAS cards installed in Linux machine use the perle-serial driver  for Linux. This driver  is 
supplied in both source RPM package format and a compressed  tar file. The procedure for 
installation of each format is as follows:

Install from Source RPM

1. Log in to the Linux system as root user. 

2. At the Linux prompt, copy the supplied perle-serial-<version>-<release>.src.rpm file onto 
your system in the /tmp directory.

3. Install the source rpm by typing the following command:

rpm –ivh perle-serial-<version>-<release>.src.rpm
4. Build the binary RPM package for your system by entering the following commands:

cd /usr/src/<packages directory>/SPECS
<rpm build command> -bb perle-serial-<version>.spec

5. Install the binary RPM which was just created. Enter the following commands:

cd /usr/src/<packages directory>/RPMS/<arch>
rpm –ivh perle-serial-<version>-<release>.<arch>.rpm

The <arch> value is the architecture of your Linux machine such as “i386” or “alpha”.

Install from Tar File

1. Log in to the Linux system as root user. 

2. At the Linux prompt, copy the supplied perle-serial .tgz file onto your system in the /tmp 
directory.

3. Unpack the file using the command:

tar –xzvf perle-serial-<version>.tgz

Notes:
The <packages directory> path name in the following instructions will be different 
depending on the Linux distribution you have installed. ( i.e. Redhat will have a 
“redhat” directory; Suse will have a “packages” directory)
The <rpm build command> will change depending on the version of the RPM utilites 
installed. For newer versions (i.e. 4.2) , the <rpm build command> is “rpmbuild”. For 
older versions use “rpm”.
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4. Build and install the perle-serial software by entering the following commands

cd /tmp/perle-serial-<version>
./tar_install.sh

Serial device naming conventions

Each port you wish to use on the PCI-RAS board must have /dev/ttyPS devices. If these 
devices do not exist on your system then you will need to create them. First, check if they 
exist.

For example, to check if ttyPS4 exists do:

ls -l /dev/ttyPS4

If a device currently exists, then it will be displayed. However, if it does not exist then an error 
message saying device not found will be reported. To create the devices use ps_addports 
<0> <# of ports-1>.

For example to create devices for 4 ports:

cd /dev
ps_addports 0 3

Setup for dial-in modem

To enable a getty login on a modem port, execute the following instructions:

1. Edit the /etc/inittab file and add an entry for each login modem port. For example,

2345:respawn:/sbin/agetty -w -I ‘AT&FE0Q1&D2&C1S0=1$SB19200\015’

where $SB is the speed you wish to configure on the port

HINT:
Alternatively you can scan for ttyPSx devices, by viewing the file /var/log/messages. 
This will display any ttyPSx devices found present in the system.

NOTE: For older PCI-RAS multi-modem cards, without V.92 support, you will 
get an error response from the modem and should use the init string 
AT&FS0=1&D1&W instead.
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Setup for dial-out modem

To access a PCI-RAS modem port, you can use standard applications such as cu, tip and 
minicom. 

Removing drivers and utilities from your system

To remove the drivers from your system under the Linux operating system proceed as 
follows:

1. At the command prompt, type rpm -e perle-serial and press Enter 

The driver and associated utilities are now removed from your system
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Installing PCI-RAS under Solaris

Installing the driver

To install the device drivers and utilities for the Solaris operating system proceed as follows;

1. Login to your system as root.

2. Load the CDROM into your system CD drive.

3. Mount the CDROM to a mount point, for example /cdrom.

4. At the command prompt, type:
pkgadd -d /cdrom/drivers/pci-ras/solaris/x.y.z/fast-sol-x.y.z.pkg comf , where x.y.z is 
the vesion number of the driver

5. Press the Enter key. 

The system now installs the driver and displays a series of messages ending with a 
successful installation message.

Upon installation of the drivers, your PCI-RAS cards are ready to use.

Serial Port Naming Conventions

By default, each port is associated with three entries under the /dev directory.

Two take the form /dev/comfxy and /dev/term/comfxy where x is the card number (1-4) and 
y is a lower case letter in the range a-p. a is port 1, ..., p is port 16. These device names are 
intended for local devices.

The third device name takes the form /dev/cua/comfxy where x is the card number and y is a 
lower case letter in the range a-p, as before. These devices are intended for use with 
modems.

These mappings can be altered by careful modification of the mkdev and startcomf scripts 
in /usr/lib/comf/i86.

Note
A re-boot of your system is not necessary as the drivers for your PCI-RAS card are 
dynamically loadable and will be loaded as soon as any software attempts to access the 
associated devices.
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Using modems

The simplest mechanism for setting up ports is to use the system administration tool, 
selecting the "Serial Ports" section. From here modems can be configured for dial in, dial out 
or bi-directional.

Setting up modems for dial in

If you set up ports for dial in you will need to disable any echo from the modem devices. The easiest 
way to do this is to use tip (or cu) and send the appropriate "at" command sequence to the modem. A 
typical ttymon port setup requires the use of the standard ldterm and ttcompat modules.These would 
normally be added into the "Streams Modules" section of ttymon port configuration (this is 
under the "expert" tab).

• To disable echo from the modem devices - ATE0Q1V0

• To enable fixed baud rate on the modem - AT&FSO=1$SB9600&D1&W. For older PCI-
RAS card, without V.92 support, the $sb<speed> command is not supported. 

For simple dial out you can use tip or cu commands . A simple connection with tip can be 
started by typing tip -<speed> /dev/cua/comf<card #><modem port #> for example "tip -
9600 /dev/cua/comf1a". Notice that this uses the modem callout device. The dial out device 
(that is /dev/term/0) would block the open of the modem until carrier (DCD) is asserted.

NOTE: For older PCI-RAS multi-modem cards, without V.92 support, you will 
get an error response from the modem and should use the init string 
AT&FS0=1&D1&W instead.

Note:
Remote modems connecting to PCI-RAS cards that are made by US Robotics require a 
&b1 to initialize the speed correctly. 
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Configure using Admintool 

The software provided with the Solaris operating system includes a utility called admintool 
which allows you to configure the extra devices you have added to your system.

To configure devices with admintool proceed as follows;

1. At the command prompt, type admintool
The Admintool: Users window is now displayed as shown in the next picture.
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2. In the Admintool: Users window, click on Browse > Serial Ports.

The Admintool: Serial Ports window is now displayed showing all serial ports currently 
present on the system
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3. .In the Admintool: Serial Ports window, select the port you want to configure. To 
configure the port, click on Edit > Modify.

The .Admintool: Modify Serial Port window is now displayed.
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In the Admintool: Modify Serial Port window you can click on the Expert button to show 
more fields, as shown in the next picture.

4. In the Admintool: Modify Serial Port window, set the parameters you require.

5. In the Admintool: Modify Serial Port window, click on OK to accept the changes you 
have made and close the window.

6. Repeat steps 3. to 5. until you have configured the serial ports for all the host cards you 
require.

7. In the Serial Manager menu click on Host > Quit  to quit Serial Manager and close the 
window.

Removing drivers and utilities from your system

To remove the software drivers from your system under the Solaris operating system 
proceed as follows;

1. At the command prompt, type pkgrm comf and press Enter 

The driver and associated utilities are now removed from your system.
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Remote Configuration

Remote configuration is a network management tool that allows you to configure the PCI-
RAS modems from anywhere in your network. As if you were on-site you can issue AT 
commands to troubleshoot and maintain your modems. The Remote Configuation feature 
has password-protection to ensure your configuration remains safe.

Basic Procedure

The following steps are valid regardless of whether the connection is established by the local 
or remote PCI-RAS modem.

1. Establish a data connection with a remote PCI-RAS modem.

2. Send three remote configuration escape sequences followed by AT and the setup 
password. Press Enter. You have 4 attempts to enter the correct password before you are 
disconnected. If the password is correct, the remote modem responses with OK.

Example: %%%ATMTSMODEM
OK

3. Type AT commands to configure the remote modem.

4. When you have finished configuring the remote modem, save the new configuration by 
typing AT&W0

5. Type ATO and press enter to exit remote configuration. You are now back to where you 
originally issued the %%%ATMTSMODEM command.

To Change the Setup Password

To change the default password (MTSMODEM) for the remote modem, implement the 
following steps:

1. Open a data communication program such as Hyperterminal and connect to the PCI-RAS 
modem you wish to change the password for.

2. In the terminal window type AT#SMTSMODEM and press Enter .

If you have previously changed the password then use your new password to gain 
access.

Example: AT#SMTSMODEM

Note:
For this procedure to work, the remote computer must be running a communication 
program ( such as Hyperterminal) and be ready for a data connection.
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3. To change the password type AT#S=xxxxxxxx, where xxxxxxxx stands for the 
password. Press Enter. The password can include any keyboard character, and can be 
up to eight characters long. The modem should respond with OK if you have enter the 
password correctly.

4. The new password is saved automatically. You can either enter more AT commands or 
exit the communication program.

To Change the Remote Escape Character

The user also has the ability to change the remote modem’s remote configuration escape 
character either locally or remotely. The remote configuration escape character is stored 
in register S9. The factory default is 37, which is represented by the ASCII code % 
percent character. Setting S9 to 0 (zero) disables remote configuration entirely.

CAUTION: If you do this remotely, you will not be able to change it back remotely.

1. Establish a remote configuration link with the remote mdoem as described in Basic 
Procedure on page 56.

2. Type ATS9=n, where n is the ASCII code for the new remote configuration escape 
character, and then press Enter.

3. Save the new value by typing AT&W and pressing Enter.

4. Type ATO and press Enter to exit the remote configuration.

Note: Passwords are case-sensitive.
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Appendix A Troubleshooting 

You need to read 
this chapter if you 
want to...

You need to read this Appendix if you require information on troubleshooting PCI-RAS.

This Appendix provides information on troubleshooting your PCI-RAS unit and includes 
information on common problems as well as some diagnostic tests.

This Appendix includes the following sections;

• Common problems on page 59

• PCI-RAS diagnostic tests on page 60
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Common problems

These are some general troubleshooting tips for common problems. As always, you can 
contact support using the details in Appendix B Contacting Perle.

• If the modem appears to functioning, but no characters are being returned, you may have 
an interrupt conflict. Check the interrupts used by existing hardware against those 
selected by the PCI-RAS (as well as card slot position which can determine selection of 
interrupts).

• If you are connecting PCI-RAS to a telephone exchange, ensure the phone connection is

• configured for tone dialling. PCI-RAS fully supports tone dialling and DTMF detection, 
however pulse dialling is not supported.

• If your PCI-RAS modem fails to make a particular connection then the problem may be 
with the telecom line or with the modem at the other end. Retry making the connection 
(and if possible try making the call with a standard phone connected to see if you can 
establish a voice call over the line). Also check the modem connection at the other end.

• If the modem at the other end does not have error correction then you will need to disable 
error correction at the PCI-RAS end by issuing to each PCI-RAS modem port: AT\N0

• In some circumstances PCI-RAS may not be able to correctly detect dial tone on the line. 
This is often indicated by a NO DIALTONE error message. Modify your communications 
software to disable dial tone detection or directly issue to each PCI-RAS modem port: 
ATX3&W

• Alternatively you may include the X3 command in your modem initialization string.

• If your PCI-RAS modem will not answer incoming calls first check that your application 
software has been configured to enable automatic receive. The default for all PCI-RAS 
modems is to have SO=0 (no auto-answer). To set auto-answer on, issue the command: 
AT S0=3

• This command will set the modem to answer after three rings. The S0 register can be set 
to answer anywhere between 2 and 30 rings. Also the S0 register can be set in the initial-
ization string.

• If you can communicate with the PCI-RAS modem ports but some ports are behaving 
unpredictably it may be that the port’s configuration has been altered. To restore the fac-
tory default settings, issue the command: AT&F&W

• If you need to reset one of the PCI-RAS modem ports then issue the command: ATZ You 
may also need to re-initialize any communications software that is active on that modem 
port.



PCI-RAS User Guide 
PCI-RAS diagnostic tests

Page 60

PCI-RAS diagnostic tests

Your PCI-RAS multiple modem card is able to perform several diagnostic tests to help you 
identify problems in the communications link. These tests are initiated using AT commands. 
To issue AT commands to the PCI-RAS modem ports you may need to perform some 
software function that puts your computer’s communications into terminal mode or local 
mode. A cursor will appear on your screen allowing you to send commands directly to each 
modem port.

This section includes details of the following tests;

• Presence test on page 60

• Local analog loopback test on page 61

• Remote digital loopback test on page 61.

Presence test

Command Test purpose Notes
AT E1 Q V1 To see if your 

computer and the PCI-
RAS modem ports are 
communicating 
properly.

If the I/O address and interrupt are set 
correctly then the PCI-RAS modem port will 
respond OK. Repeat this test for each of the 
PCI-RAS modem ports. If the PCI-RAS fails 
to respond OK at all then first check that the I/
O address range and interrupt that you 
configured (with SW1 and jumper J1-5) does 
correspond to the settings you configured in 
your software. Then check that the PCI-RAS 
does not have I/O address or interrupt conflict 
with existing hardware installed in your 
system.
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Local analog loopback test

Remote digital loopback test

Command Test purpose Notes
AT&T1 This tests the path that 

includes the PCI-RAS 
modem under 
inspection and the PC 
host interface.

Note
All loop back tests 
must be performed 
with error correction 
disabled so first issue 
the command: AT\N0

This will place the modem in normal speed 
buffered mode. To activate loopback issue 
the command AT&T1.

The modem will respond with the message: 
CONNECT XXXX. Any data that is sent to the 
modem will be looped back. To terminate the 
test, issue the escape sequence: +++. After 
OK is returned, issue the command ATZ to 
return the modem to its normal operating 
state.

Command Test purpose Notes
AT&T6 Remote digital loop-

back tests the path 
that includes the local 
modem, the remote 
modem, the telephone 
circuit and the PC host 
interface.

Note
All loop back tests 
must be performed 
with error correction 
disabled, so first you 
must issue the 
command AT\N0. This 
will place the modem 
in normal speed 
buffered mode. 

The digital loop-back test also requires that 
you have already established communication 
with a remote modem and that the remote 
modem has remote digital loop-back enabled 
AT&T4. One you have established the 
connection to the remote modem, issue the 
escape sequence +++ to return you to the 
command mode. Issue the loop-back 
command AT&T6. This causes a loop back to 
occur at the remote modem. Any data that is 
sent to the modem will be looped back at the 
remote modem. To terminate the test, issue 
the escape sequence +++. After OK is 
returned, issue the command ATZ to return 
the modem to its normal operating state.
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You need to read this appendix if you want to contact Perle for technical support or any other 
queries about this product.

This appendix includes the following sections:

• Making a technical support query on page 62

• Repair procedure on page 64

• Feedback about this manual on page 64

• Perle support centres worldwide on page 65

Internet access

Email

Making a technical support query

This section contains the following information about making a query:

• Who to contact on page 62

• Information needed when making a query on page 63

• Making a support query via the Perle web page on page 64

Who to contact

If you bought your product from a registered Perle supplier, you must contact their Technical 
Support department; they are qualified to deal with your problem.

If you are a registered Perle supplier, and bought your product from Perle, contact Perle 
Technical Support at the offices listed below.

Click here to access the our website at 
the following URL: 
http://www.perle.com 

Click here to email Perle at the following address:
Email: support@perle.com 
  
Making a technical support query
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Information needed when making a query

When you make a technical support enquiry please have the following information ready:

Hint
Print out this page and fill in the table provided with the basic 
information you need.

Item Write details here
Product name and version

Problem description

Operating system version
Driver version
Details of any other cards 
installed in your system

Your name
Company Name
Country
Phone number
Fax number
Email address (if available)
  
Making a technical support query
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Making a support query via the Perle web page

If you have an internet connection, please send details of your problem to Technical Support 
using the email links provided on the Perle web site in the ‘Support’ area.

See also Perle support centres worldwide on page 65 for email links and other contact 
details for the Perle technical support centres.

Repair procedure

Before sending a unit for repair, you must contact your Perle supplier. If, however, you bought 
your product directly from Perle you can contact directly. See Perle support centres 
worldwide on page 65 for contact information.

Customers who are In Europe, Africa or Middle East can submit repair details via a website 
form shown in the next picture. This form is on the Perle website, www.perle.com, in the 
Support area.

In the USA and Asia contact the office shown in the Technical Support section.

Feedback about this manual

If you have any comments or suggestions for improving this manual please email Perle using 
the following address:

docfeedback@perle.com

Please include the title, part number and date of the manual (you can find these on the title 
page at the front of this manual).

Click here to access our website at the following URL:
http://www.perle.com

Click here to access our web site at the following URL:
http://www.perle.com/support_services/rma_form.asp 
  
Repair procedure
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Perle support centres worldwide

PCI-RAS

Note
Perle offers free technical support to Perle Authorised Distributors and Registered Perle 
Resellers. 
To access technical support please visit the Perle website at 
www.perle.com/support_services/index.shtml.
If you are unable to find the information you require, please feel free to contact our technical 
support teams by email using the addresses shown in the next table.

Country Address Email
North America Perle Systems Ltd. 

60 Renfrew Drive 
Markham 
Ontario 
Canada 
L3R OE1

Email: ptac@perle.com 

Europe Perle Systems Europe Ltd.  
3 Wintersells Road  
Byfleet Surrey 
KT14 7LF 
UK

Email: ptac@perle.com 

Asia Perle Asia Pacific (Pte) Ltd. 
190 Middle Road 
#19-05 Fortune Centre 
Singapore 188979

Email: ptac@perle.com

Worldwide Perle Systems Ltd. 
60 Renfrew Drive 
Markham 
Ontario 
Canada 
L3R OE1

Email: ptac@perle.com 
PCI-RAS  
Perle support centres worldwide
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